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1.0 Introduction

VbReader is an off-line reader program written in Visual Basic and intended to
provide a simple and reliable off-line reader for the average user, in a Windows 3.1
environment.

The program processes mail packets conforming to the Quick Mail format.

It incorporates the features needed to unpack mail packets, read the messages,
write replies and generate a mail packet containing the replies. The interface was
designed to be simple and easy to understand and use.

Users of this program will require a communication program to perform the
download and upload of mail packets to the bulletin board of their choice.

This program is "Freeware". Registration is not required. The author would like that
users send him Email at the following address, to comment on the program, suggest
improvements, etc. The author intends to be very responsive to user requests.

Send Email to:
daniel.page@canrem.com
or
Daniel Page, user at Canada Remote Systems BBS



1.1 Requirements

The user requires the following:
- Windows 3.1
- PKZIP and PKUNZIP data compression software
- Communication program
- VGA or better video monitor (800x600 resolution preferred)
- Although the program will run on a 286, a 386 is preferred

2.0 Installation

2.1 Unzipping the distribution kit:

-Create a directory on your hard drive. Name it READER or some other
appropriate name. For example:
md c:\reader

-Copy the reader14.zip file to this directory. Make this directory your current
Directory. Unzip the distribution file: (PKUNZIP must be in your path)

copy a:\reader14.zip c:\reader

cd \reader

PKUNZIP *.zip

2.1.1 Contents of the Distribution Kit

The distribution file contains the following files:

reader.exe ; VbReader Program

vbrun200.dll ; Visual Basic Dynamic Link Library
vbreader.dll ; Custom Dynamic Link Library

threed.vbx ; 3d Controls VB extensions

news.bat ; Batch file to display bbs news bulletins
news.pif ; Pif file to display bbs news bulletins
welcome.bat ; Batch file to display the bbs welcome
screen

welcome.pif ; pif file to display the welcome screen
explode.pif ; pif file to launch PKUNZIP via explode.bat
explode.bat ; batch file launched by the explode.pif file
compress.pif ; pif file to launch pkzip

compress.bat ; batch file launched by the compress.pif file.
85140em.fon ; Large Terminal Font

vgaoem.fon ; Small Terminal Font
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2.1.2 Additional Files:

services.pif ; Sample Pif file to display the services data

files.pif ; Sample Pif file used to launch the files display editor
editor.pif ; Sample Pif file used to launch a DOS editor.
tagfile.txt ; text file containing tag lines

2.2 Font Installation

Invoke the Windows Fonts installation program from the Windows Control Panel.
Choose the Add option. Direct the program to search in the reader directory. It
will display the following: Terminal font for the IBM 8514 and Terminal [US] [Set
#6]. Click on the two fonts to select them, then click the OK button. The fonts will
be installed. If the fonts are already installed in your system, windows will display a
message to that effect. You may then cancel the installation of the new font.

NOTE: In order to function properly, the program requires that
BOTH fonts be installed.

2.3 Dynamic Link Libraries and Visual Basic Extensions

The program uses two Dynamic Link Libraries:
-VBRUN200.DLL
-VBREADER.DLL

The program also uses a Visual Basic Extension file
- THREED.VBX

Copy the *.DLL files to your Windows\system directory. Assuming this is on drive
C:
copy c:\reader\*.dll c:\windows\system

Copy the THREED.VBX file to your Windows\system directory.
copy c:\reader\*.vbx c:\windows\system

Make sure that this is the only copy of the program on your system. If you have
used other Visual Basic programs before, it is possible that an older version of this
file has been installed previously. You must use the new version of the
THREED.VBX file, as distributed with the kit.

2.4 ANSL.SYS



- In order to properly display the ANSI graphics that are usually included in the
Bulletins files from the BBS, you must load the ANSI driver provided with your DOS
operating system. This is done by editing your config.sys file. Add the following
line:

device=c:\dos\ansi.sys

2.4 PKZIP/PKUNZIP

VbReader uses PKZIP and PKUNZIP to compress and expand messages. The
program was designed to use version 1.10 of the zip utilities.

Following the release of the new PKZIP (PKZIP204C), some difficulties were
encountered. The result is that the mechanism to invoke the new archive program
has changed somewhat.

Originally, the archiver was invoked directly through a PIF file, with VbReader
passing the appropriate parameters. As the new PKZIP proved too unstable to be
used in this manner, the PIF files (COMPRESS.PIF and EXPLODE.PIF) have been
changed to invoke BAT files (COMPRESS.BAT and EXPLODE.BAT). The contents
are explained below:

2.4.1 Compress.bat

When creating a mail packet, the new PKZIP was found to be overzealous. It not
only deleted the old replies after compression, but also deleted the REPLIES
directory. In order to correct this, the batch file changes the Current Directory to
the replies directory. In addition, DPMI support had to be disabled by including
the -) switch. You may need to edit this file to match your installation. Here is the
code:

rem *************com press . Bat**************

rem Set Current Drive to the drive containing the replies directory
rem Substitute your own drive letter

c:

rem Set Current Directory to the replies Directory

rem Substitute you own directory structure
cd\reader\replies

rem Invoke PKZIP and pass parameters

rem Substitute your PKZIP path.

c:\pkz2\pkzip -) %1 %2 %3

rem If using PKZIP 1.10, remove the -) switch
rem*************End of Com press. BAT**********************

2.4.2 Explode.Bat



When expanding a QWK packet, the new PKZIP proved unstable. The batch file
provides a means of disabling DPMI support.

kkkkkkkkkkkk kkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkkk
rem Explode.Bat

rem Substitute your own path

c:\pkz2\pkunzip -) %1 %2

rem If using the older pkzip110, remove the -) switch
rem**********End of Explode.Bat**************************

While | am aware that the present method of invoking the archiver may seem
somewhat crude, it works. This method allows the greatest amount of flexibility in
terms of modifying parameters which may be required to make the new PKZIP
reliable on any system. A later release of VbReader will hopefully be able to
include a more streamlined method of launching the archiver, but until the verdict
is totally in regarding PKZIP204C, this is the safest method.

2.5 Program Manager Setup

Using the File Manager, drag the program reader.exe to a program group of your
choice.

2.6 Last Installation Step

- If you edited your config.sys or autoexec.bat files, reboot your system to allow
the changes to take effect.

3.0 Initial StartUp of VbReader

To start VbReader, you may double-click on reader.exe with the file manager, or
double click on the reader icon in a program group.

3.1 Initial Configuration

When the program is first started, it will look for a configuration file (reader.ini).
Initially, this file will not exist. The program will then invoke the configuration menu.
The following options should be verified and adjusted to your needs:

3.1.1 Paths and Directories

Examine the Directories listed. The defaults provided should be adequate. If
you have specific upload and download directories for your communication
program, you should change the uploads and download paths to those
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directories so that VbReader will be able to access mail packets directly from the
communication program's directories.

Once you have configured the options, click the Done button. The program will
proceed to create the required directories listed in the configuration menu. The
program will notify you for every directory created. Just click the OK button until
the mail screen is displayed. We are now ready to open a mail packet. However,
before we do, you should invoke the second configuration menu.

3.2 Complete Configuration

Click on the Quick Configuration menu item. The first option listed is Screen
Options. Select this option.

3.2.1 Screen Options Menu

3.2.1.1 Font Name, Font Size and Font Style
The Font Name list box allows you to chose the fonts that will be used in the
main view screen, as well as the personal signature text box. Clicking on the
button on the right side of the box will display the font names installed in your
system. Click on the font you wish to use to read and write messages.

Note that you can also alter the appearance of the font by clicking the Font Style
radio buttons to make the font Bold or Normal. In addition, the Font Size text
box allows you to select the size of the font.

As you select a new font or modify a font characteristic, the text box at the
bottom right of the menu screen will display the result. Choose the font and font
style which most appeals to you.

3.2.1.2 Screen Colors
You can choose the foreground and background colors used in the main reader
screen by clicking on the desired colored boxes in the two frames at the bottom
left of the menu screen.

The result is again displayed on the sample text box.

3.2.1.3 Opening Size
This option determines if the program will open in full screen mode or in normal
mode when it is invoked.

3.2.1.4 Line Length
This option determines where a line wrap will occur when a reply or new
message is entered. While you type a message, the lines will wrap when the
text reaches the right edge of the edit screen. However, because the fonts used
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and their sizes can be selected by the user, this wrap may not be at a desirable
location. The line may be too long or too short. For this reason, the final line
wraps are inserted by the message processing algorithms when a message is
saved. This field determines at what character the wrap occurs. The default
number of 76 is recommended.

3.2.1.5 Quote Width
When the text of a message is inserted in a reply, this field determines at what
character position the quoted text will be truncated or wrapped. This field
should always be equal or smaller than the chosen Line Length. When this field
is smaller than the Line Length, the resulting text will be centered in the edit
screen.

3.2.1.6 Quote Mode
When inserting quoted text in a reply, this option determines whether quoted
lines that exceed the Quote Width should be truncated or wrapped to a new line.

Generally, the Truncate option with a Quote Width of 76 results in text that is
better formatted. The wrap option works better if the Quote Width is around 40
characters.

3.2.2 TagLines Menu
The third option listed in the Quick Configuration menu item is the TagLine
menu. Clicking on this option will invoke the second configuration menu. This
menu allows you to modify the following options:

3.2.2.1 Your Name:
This option sets your user name. This is used when entering replies or new
messages.

3.2.2.2 Your Tag Line:
This is your default tag line.

3.2.2.3 Tag File Name:
The name of a file containing tag lines. This file must reside in the directory
listed in the first configuration menu. VbReader comes with a file containing
4500 tag lines. This file should be moved in the DataFile directory. By default,
the file name is Tagdfile.txt. You may change this to any name you wish. Just
make sure that you tell VbReader the correct location and name of the tag file,
via the configuration menus.

3.2.2.4 Your Signature Lines:
This text box contains the signature text which will be appended to the end of
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the messages you write. Note that the font used in this text box is the same as
the main read screen font. Should you wish to make "boxes" or other patterns,
make sure that you use a fixed pitch font to preserve the required spacing.
Three such fonts are available : Terminal, 8514o0em, and Fixedsys. Once your
pattern has been entered, you may revert to any desired font. Your pattern
spatial characteristics will be distorted, but when your message is read by the
recipient, it will be correct, as most other off-line readers use fixed pitch fonts.

3.2.2.5 Default BBS ID:
Finally, this box allows you to specify a default BBS name. Once you have read
a mail packet, this field will contain the BBS identity code of that BBS.

After having set those options, click Done and the program returns you to the
main screen.

3.2.3 Editor Selections
Now select the third item in the Quick Configuration menu, Editor Selections.
The following options are displayed:

3.2.3.1 Files List Editor:
This option allows you to select the editor which will be used to display the new
files list downloaded from the BBS. The default is the WRITE program shipped
with windows. You may specify your favorite editor. If this editor is a Windows
based editor, you need only specify the program name. If the editor is not in
your path, you must include the full path.

ex: deskedit.exe
or
c:\ndw\deskedit.exe

If the editor is a DOS application, it is best to insert the name of a PIF file which
will supply the required parameters to Windows in order to launch the editor.
Normally, this pif file will contain the name of the editor and will launch the editor
in Windowed mode. See the example pif files provided (files.pif and
services.pif).

3.2.3.2 Services Editor:
This editor selection is used to display the services data files downloaded from
the BBS. See the files editor selection above for details in configuring this
option.

Note: Services are not supported in this version of the program.
Should a service packet be received, you will be able to see a
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listing of it's contents via the View Items menu. In order to
see the contents you will have to use an external program.

Now return to the main configuration menu.

3.2.3 FidoMode:
The fifth item in the Quick Configuration menu is Fido Mode.
This option changes the tear line characters to a string of character which FIDO
BBS systems will allow. When this option is OFF (unchecked) the reader is PC
Board mode, the normal mode.

3.2.4 Mode Frangais
This mode will change the quote line used when replying to a message. When it
is checked, the quote line is in French. To change the Keyboard to French
mode, use the Control Panel, International option.

3.2.5 Saving the Configuration
We are done with the configuration. Do not forget to click the last option, Save
Configuration to Disk.

4.0 A Quick Tour of the Program
4.1 Opening a Mail Packet

Click on the File menu. At this point, a number of items are enabled: Open Mail
Packet, Delete Mail Packet, Create Replies Packet, Printer Config and
Cleanup and Exit. Click on the Open Mail Packet item. The program will look in
the work directory for existing data. If you previously had opened a mail packet,
the work directory would contain files. At this point the program would ask you if
you wished to purge the directory. However, since at this time you do not have any
data in the work directory, the program will directly invoke a file dialog box. The
box will display the contents of the download directory. Select a mail packet.

Once a mail packet is selected, the program will launch PKUNZIP in a DOS
window. The packet will be expanded and the files installed in the work directory.
Once the expansion process is complete, you may read the messages.

4.2 Reading Messages

Click on the View Items menu option. A list of options appear.

4.2.1 Personal Mail
Clicking on this option will cause the program to search for personal messages.
If any exist, a list will appear, listing the message dates, originator, destination
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(you) and the subject. Double-click on the desired message to view it. Or use
the Arrow keys or Page Down or Page Up keys to select a message and press
Enter to view it.

4.2.2 Join Conference

Clicking on this item will cause a list of conferences to be displayed. The
program will display only conferences in which there are messages to read. The
list also displays the number of messages in each conference. Double-click on
the desired conference. At this point, a list showing the available messages is
displayed. Like the Personal Messages list, it displays the Subject, Message
Number, Originator, Destination and the message index number. Double Click
on a message to view it., or use the Arrow Keys, Page Down or Page Up Keys
followed by ENTER.

4.2.3 New Files
This menu item will cause the program to invoke the editor program selected in
the Files Editor configuration option. The default is Write.exe, the editor
bundled with windows. The editor will then display the list of new files which is
usually included in your mail packet. While in the editor, you may search for
topics, edit the file, and generally use normal editor functions.

4.2.4 BBS News
This option will launch a DOS window and will cause the BBS News file to be
displayed in this window. If the news file contains ANSI colors and graphics,
those will be displayed, provided that ANSL.SYS is loaded in your config.sys file.
At any time, you may interrupt the display by typing  cntrl-c.

4.2.5 Services
If services were include in the packet, a list will appear listing the services
included in the mail packet. You will then have to manually launch an editor,
and/or PKUNZIP to process the service. A future version of the program will
process services fully.

4.2.6 Welcome Screen
Like the BBS News menu, this option launches a DOS window and displays the
BBS welcome screen, if this screen was included with your mail packet. Again,
you must have ANSIL.SYS loaded to allow colors to be displayed. After the
screen is displayed, type <enter> to close the window.

4.2.7 Good-bye Screen
Like the BBS News menu, this option launches a DOS window and displays the
BBS good-bye screen, if this screen was included with your mail packet. Again,
you must have ANSIL.SYS loaded to allow colors to be displayed. After the
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screen is displayed, type <enter> to close the window.

4.3 Managing the Reader Screen
Once in the read screen, you may select messages to view by one of two
methods, mouse or keys.

4.3.1 Mouse Method
First, you may use the horizontal scroll bar at the bottom right of the screen.
Clicking on the buttons at either end will select the next or previous message in
the conference. Clicking on the scroll bar will increment or decrement the
message pointer by larger amounts (total number of messages / 10). You may
also click on the "thumb button" and drag it left or right, thereby selecting
messages.

4.3.2 Keys
For faster control of the screen, you may use the arrow keys. The up and down
arrow keys will scroll the view screen up and down by a full screen. The left and
right arrows will select the previous and next message respectively.

Note that for the keys to function as expected, the scroll bar must have the
focus. Should the keys cease to function as expected, use the mouse and click
on the scroll bar to restore the focus to that control.

Note that all controls displayed in the reader screen have ALT Keys assigned to
them. Each control has an underlined letter in it's caption. To activate a control,
press the ALT key and the underlined letter.

4.4 The Message List

The Message list will appear once you select a conference from the Conference
list. While reading messages, you may view the message list once more by
clicking on the Message List button bar under the message scroll bar at the
bottom right of the reader screen. You may also use the ALT M key combination.

While viewing the message list, the Up and Down arrows will move the selection
bar up or down by one message. PageUp and PageDown will move the selection
bar for an entire screen. You may read a selected message by double clicking on
it, or by pressing the ENTER key.

5.0 Entering a Reply
5.1 Starting the Process

While reading messages, you may enter a reply by clicking on the Reply button.
At this point, the program will ask if you wish to include the message in your reply.
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If you answer yes, the program will copy the message to the edit screen and
include quote marks and a quote announcement at the top of the message.
Otherwise, the reply screen will be shown empty.

5.2 Controlling the reply destination
Normally, the reply is automatically addressed to the person whose name appears
in the From: field at the bottom right of the read screen. In most cases, this is
adequate. However, in some cases, you may wish to address your reply to the
person who started the subject thread. In such cases, you may re-direct the reply
by doing the following:

Before pressing the Reply button, use the mouse and select the name of the
person in the TO: field at the bottom right of the reader screen. Like all windows
programs, you select the name by a "Click and Drag" operation on the field. Once
the name is selected, copy it to the clipboard by typing <cntrl Insert>. Invoke
the reply screen and paste the new destination over the TO: field by selecting the
name (Click and Drag) and typing <Shift Insert>. You may also need to modify
the quote line at the top of the message, depending on the context.

Should you wish to send this reply to a person whose name is not displayed
anywhere, just type the correct name in the TO: field.

5.3 Setting the message security
The message you enter may be either Private or Public. When private, only the
recipient may read it. When public, anyone in the conference will be able to read
it. The security level is set by clicking on the appropriate radio button control at
the bottom of the screen.

5.4 Other Displays

At the bottom of the reply screen you will note a number of display fields. They
are used to display information about your message. This includes the
conference number, the time and date of your message, and the message
number of the message you are replying to.

5.5 Editing Commands
The editor is not very complex but quite functional. You may use the mouse to
move the cursor to any insertion point in the text. The mouse will also allow you
to select text by doing a Click and Drag operation.

Once text is selected, you may delete by using the delete key, or cut or copy it to

the clipboard by using the Edit menu. Once text is in the clipboard, you may

paste it to another location. As a short cut, you may use the cntrl Insert and

shift Insert key strokes to copy text to the clipboard and to paste it back in your
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message. The clipboard mechanism also allows text to be transferred to and
from other applications.

The text will automatically wrap at the right edge of the screen. Using the
ENTER key will move the insertion point immediately to the next line. While
typing new text, do not use the ENTER key at the end of each line. This inserts a
"hard" newline character. This is unnecessary as the program will automatically
format your message when it is saved. The reason is that you may be using
proportional fonts, in which case line lengths will vary for a given number of
characters. Pressing the ENTER key will insert a hard newline character,
probably at the wrong place. Use the ENTER key only to terminate a paragraph.
VbReader functions very much like a word processor.

Even if a line of text appears overly long, do not type ENTER. Let the program
wrap it on screen, and format it when the message is saved.

Should you wish to verify the formatting, use the Your Replies menu item. This
will allow you to view and re-edit your replies. At this point the message has been
formatted for display in a standard DOS editor screen (i.e.: the line length is
adjusted to fit in a 80 character DOS editor screen.

Should the editing process (for a previously entered reply) involve changing the
length of a line, delete the CRLF characters at the end of the line (restore the
basic reader screen wrap). When the message is saved, it will be reformatted

properly.

Tabs are inserted by typing the cntrl Tab key sequence. That is because the Tab
keystroke is used to navigate between screen objects and controls.

5.6 Editor File Commands

While in the editor window, you may save the displayed text or insert a text file in
the editor window by selecting the appropriate option in the File menu in the
menu bar.

5.7 Tag Line Selection
Once your message is complete, you may wish to select an appropriate tag line.
At the bottom center of the screen, you will see a button marked Tag Line.
Clicking on this button will invoke the tag selection window. This consists of a
drop-down list box. When first invoked, the list box displays the current tag line.
Clicking on the arrow button on the right of the text box will cause a list of tag
lines to be displayed. If the number of tag lines exceeds the area available to
display them, a scroll bar will also appear. Select the desired tag line by clicking
on it. Click on the OK button to return to the edit screen. Note that the list box
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can only display the first 1000 tag lines in you tag file. Also Note that the tag line
is not displayed in the edit screen. It is appended to the end of your message
when you save it.

5.8 Saving the message
When you are done with the editing, click on the Save button. A dialog box will
appear asking you to confirm. If you confirm that you wish to save the message,
the message will be appended to the reply file in the replies directory. If you
select Cancel, you will be returned to the edit screen. Clicking the NO button will
delete the reply and return you to the read screen.

6.0 Entering a New Message
You would use this option when you wish to enter a new message, not linked to
any particular message in a conference. The procedure is very similar to the Reply
procedure except for the following:

6.1 Selecting a Message Conference

When entering a new message, you may explicitly declare which conference your
message in intended for. You may either type the conference number in the
appropriate field at the bottom left of the editor screen, or you may pick a
conference from a list that is displayed when you click the View Lists menu item
in the menu bar at the top of the screen.

When the list is displayed, select a conference by clicking on it. Note that the list
will only display the first 3000 conferences listed in the mail packet control file.

6.2 Selecting a Recipient
To address the message to a recipient, simply type the person's name in the TO:
field at the bottom right of the edit screen.

7.0 Editing Your Replies

Before sending your replies to the BBS for everyone to read, you may wish to read
them and perhaps edit them. This can be accomplished with the Your Replies
menu option.

Clicking this option will bring up a list of your replies. Double-click on the reply you
wish to read. It will be displayed in the Read window. The Replies feature works in
the same manner as the Read Messages mode.

When the editing of replies is complete, pressing the DONE button will cause the
old replies to be erased and a new reply file created with the newly edited replies.
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8.0 Creating a Replies Packet
Select the Create Replies Packet option of the Files menu. This will launch the
compression program which will compress your replies and move the resulting file
to the uploads directory. You will be asked if you wish to delete the old replies (the
ones that are now being processed). If a mail packet exists in the upload directory,
the program will ask whether you wish to continue. If you continue, the old replies
packet will be overwritten.

Once your reply packet is created, launch your communication program and upload
it.

9.0 Printing Messages
The program can print a single message at a time. The printing feature is not as
complete as it could be in that there are no provisions for proper pagination of
multipage messages, even though the program will print multipage messages.
However, most messages will fit on a single page.

9.1 Printer Config
In the File menu item, you will find the Printer Config... item. Clicking on this
item will bring up a dialog box containing printer configuration items relating to
VbReader. You have control over the following options:

9.1.1 Printer Font
This is a combo box containing the available printer fonts for the printer
presently selected. The current font is displayed in the text box portion of the
combo box. Clicking the button on the right hand side of the box will expand the
list to display all the available fonts. Click on the desired font to select it.

9.1.2 Font Size
Use this text box to select the printer font size. Type in the size that you wish to
use. If this size is not available, Windows will substitute the closest match.

9.1.3 Left Margin
This is the width of the left margin in inches. 1 inch is usually a good choice.

9.1.4 Top Margin

This is of course the top margin spacing. For most single sheet dot matrix
printers, set this to 0. For most other kinds of printers, set it to 1 inch.

10.0 The Twit Filter

Under the Tools menu, you will find the Twit Filter option. This will invoke a dialog
box containing a Combo box, a check box and a couple of control buttons.. The
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Combo box contains a list of names of message originators which you wish
removed from all message lists. You can add names and remove them at will.
When the program is terminated, all changes to the twit list are saved in a file
called TwitFile.txt in the DataFile directory.

When the Twit Filter is activated via the check box, all messages bearing a author
name included in the twit list are deleted from the message lists. Should you wish
to see them, turn off the filter and re-select the conference you are interested in.
As the message list is processed, messages previously filtered out will re-appear.

11.0 VbReader Limits:

Number of Conferences containing messages: 700
Number of Conferences listed in the View List menu: 3000
Maximum Conference Number 9999

Number of Messages per Conference 700

Number of Replies 700

Number of TagLines displayed in the list box 1000
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